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I.  Installation
Here's a new software CD. It can be used  to upgrade an existing installation.
The installation procedure is

I.A.  Insert the CD.
I.B.  It should autostart. 
If it doesn't, you can click on the SetupDNAVIEW....EXE file on the CD to make it start.

I.C.  Answer the prompts.
Some of the prompts below may not occur.
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I.C.1.  The password if requested is ......
I.C.2.  Select destination location
I.C.2.a.  If updating, choose the directory where DNA@VIEW already is. 
I.C.2.b.  For a new installation, anywhere you like. Examples:

I.C.2.b.i.)  Traditionally DNA@VIEW was installed to  C:\dnaview. 
I.C.2.b.ii.)  Typical Windows style would be C:\Programs and Files\dnaview.

I.C.2.c.  For installation to a network server, note that there must be a mapped drive letter. See the DNA@VIEW manual
§XVI.D

I.C.3.  Select components
I.C.3.a.  Update DNAVIEW program files to version 28.35

Use this option to leave your data unchanged, but to perform either or both of
I.C.3.a.i.)  change the program version to a different version (probably newer)
I.C.3.a.ii.)  install or re-install a startup file or desktop startup icon

I.C.3.b.  Install DNAVIEW version 28.35 programs and empty data files
For initial installation or installation of a second copy (in a different folder) or to destroy all case data.

I.C.4.  Select start menu folder
This refers to where DNAVIEW will be found when you click START, All Programs.
I.C.5.  Select additional tasks
I.C.5.a.  Create DNAVIEW desktop icon. Very handy – an icon on your desktop to click to start DNA@VIEW.
I.C.5.b.  Create DNAVIEW start menu entry. Less handy but some prefer it.
Click the obvious buttons to complete installation.

I.D.  Install Pater
If installing PATER as well as DNA@VIEW, running the PATER installer – SetupPATER....EXE on the same CD
– is a separate operation. Use My Computer to double-click on the installer to run it.

I.E.  Icons
The installation produces a folder called DNAVIEW on the
desktop with a collection of icons. 
I.E.1.  Icon functions
Their functions are as follows – 
I.E.1.a.  DNAVIEW – starts DNA@VIEW
I.E.1.b.  PATER – starts PATER
I.E.1.c.  DNAVIEW – starts DNA@VIEW and allows the few

graphics commands, i.e. drawing of allele frequency
histograms.

I.E.1.d.  DNAVIEW Report Viewer – Utility program to open DNA@VIEW
Kinship or Paternity reports (the "formatted" version) cleanly in Excel.
I.E.1.e.  Connect USB printer

These several icons create the connection that is necessary for DNA@VIEW or
PATER, which nominally print to an old-fashioned "parallel" port – LPT1 or LPT2
– to print to a USB or network printer. You will probably only need one of them;
which one is a matter of convenience.

Customization of the icon is necessary. If you double click on one of them and
it is not yet customized, it will give instructions for customization.
I.E.1.e.i.)  Print icon customization

»  Choose the network or USB printer you wish to print to.
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»  Determine its "Share name". The easiest situation is if the printer can be
shared through your own computer. Open "Printers and Faxes" from or
near the Control Panel, right click on the printer you want to use, and
choose Properties. Choose the Sharing tab. Choose the option "Share this
printer" if possible. Note the Share name. If there is none, add one of your
choosing, preferably without spaces.
Click ok to close the printer properties window.

»  Right click on the icon "Connect USB printer, LPT1". Choose Properties.
Select the Shortcut tab. Click in the Target window, hit End, and type
space followed by the printer's share name. Click Apply.

»  While the Properties are open is a good time to complete customization of
the print icon per §I.E.2.

I.E.1.e.ii.)  Establish printer connection
Now you can double-click on the icon itself to invoke it in order to establish a
connection with the printer. The connection is suppose to be permanent but if it
happens to disappear you can invoke it again.

I.E.1.f.  Repair – may rarely be necessary to repair e.g. a problem caused by unceremonious shutdown of DNA@VIEW
or PATER such as by a power failure.

I.E.1.g.  Reset – has the potential to discard all DNA@VIEW data files and reinstall empty ones. Clicking on the icon
is harmless though; it will not do anything except to tell you what you have to do to actually reset.

I.E.2.  Customizing the icons
There are a few detailed icon option settings that it was not possible to incorporate into the installer. Therefore for best
performance and appearance I suggest the following steps, for each icon that you will use:
I.E.2.a.  Right-click on the icon. On the fly-open menu, click on Properties.
I.E.2.b.  Enable the mouse in DNA@VIEW and PATER

Choose the Options tab. Be sure that Quick Edit Mode is NOT checked.
I.E.2.c.  Choose a convenient window size.

»  On the Options tab under Display Options, choose Window (rather than Full Screen).
»  Choose the Fonts tab and choose a good-sized font. If you choose Lucida, then size 18 or 20 is about right.
»  Choose the Layout tab and ensure that Window Size is 80 (width) × 25 (height). 

II.  Running DNA@VIEW
II.A.  Startup
II.A.1.  Click the icon or choose DNA@VIEW from the start menu.
II.A.2.  Annoying message
If, when trying to start DNAAVIEW/Toolbox, Windows complains about COM1 and asks "Close or Ignore?", click
"Ignore" and everything will work fine.
II.A.3.  Printing from DNAAVIEW
II.A.4.  Computer seem slower? (DNA@VIEW PLOT only)
If DNA-VIEW – when started with the DNAVIEW Plot icon – plays badly with others (hogs all the CPU cycles, even
printing from DNA-VIEW takes one minute), the problem is process priority between DOS and Windows XP.
This problem won't happen if you start the program with the (simple) DNAVIEW or PATER icon described above
(§I.E). It's only an issue if you use the DNAVIEW PLOT icon.
A basic fix – Lowering priority of DNA@VIEW in Windows
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II.A.4.a.  Start Windows' Task Manager (While
holding Ctrl-Alt, hit Del)

II.A.4.b.  Start DNA@VIEW
II.A.4.c.  At the Task Manager:

II.A.4.c.i.)  Click the "Processes" tab.
II.A.4.c.ii.)  Find the DOS process, which is

called ntvdm.exe by typing n a
sufficient number of times. Right click on
it.

II.A.4.c.iii.)  From the fly-out, choose Set
Priority

II.A.4.c.iv.)  From the next fly-out, click on
Below Normal

II.A.4.c.v.)  Close the Task Manager with the
X

II.A.4.d.  This change is temporary, lasting only until you close DNA@VIEW.
II.A.5.  Menu selection – Very important! 
Please note §XV.A.1.d.i about the context menu selection method!

III.  Miscellaneous
III.A.  Population databases
A variety of population allele databases are included as part of a new install. They are also available to import into an
existing installation from the \freqs directory of the CD via the first Import/Export option. Additional databases are on
the CD in the Freq folder.

III.B.  Sample data files
The installed system has some sample data files. For example, to quickly see a casework computation, try §IV.C in the
manual.

III.C.  Option for choosing locus name format
The Options command (in Housekeeping) includes an option Locus name style like ... . It offers four possibilities for
locus name display viz:

(a) The bare locus name, such as D16S539
(b) Include the chromosomal information,
(c) Include the category such as STR.

III.D.  Questions
Please feel free to ask if you have any questions, or any difficulty at all.
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compute one locus

IV.  New features
IV.A.  Convenience features for type-in responses
Use the help key F1 for a popup that documents the special
keystrokes described below. This help is available whenever
you are supplying a type-in response, whether one-line (e.g.
when typing a comment or inventing a file name), or when
entering a kinship scenario.
IV.A.1.  Editing keystrokes
Ctrl-Del deletes a line (if multiple line input) or the line.
Ctrl-Insert inserts a blank line (useful if editing a Kinship
scenario). Ctrl-z restores the text as it was before you began
editing.
IV.A.2.  Memory
IV.A.2.a.  Scrolling to previous responses
PageUp and PageDown (sometimes also Up-arrow and Down-arrow) scroll through previous type-in responses. Ctrl-
Shift-Delete deletes an item from the memory list.
IV.A.2.b.  Menu of previous responses
Ctrl-Up-Arrow pops up a menu of previous responses.
DEL deletes an item from the list of previous responses.

IV.B.  Paternity computation mutation calculation
Case option: Include mutation possibilities if effect  > x% (e.g. 1!10%)

A new choice in Case Options (in the Paternity Case command) lets the user control to what
extent mutation possibilities are considered. Consider an example such as

Mother 12 14
Child 12 15
Man 12 16.

Obviously we must consider the possibility of a 16ý15 (paternal) mutation as part of the computation of X=Pr(given
DNA types|paternity). Another possible explanation, not far-fetched, would be a maternal 14ý15 mutation with the
man contributing the 12. A computation of X should probably include both of these possibilities. 
There are further theoretically possible explanations as well, such as with two mutations and mutation by more than one
step. Including all of these in the computation would introduce complexity – difficulty in verifying the computation –
with no worthwhile gain in accuracy. It seems better to leave trivial terms off. 
The mechanism implemented is to give the user the choice of omitting any terms that would affect the answer by less
than a user-chosen percentage.

IV.C.  Paternity analysis detail: compute one locus
This Paternity Case option allows convenient analysis of a specified
pattern. It uses data from the presently selected case as a starting point,
but permits arbitrary modification.
IV.C.1.   Typical operation
IV.C.1.a.  Select a locus – e.g.

D8S1179 data from
the menu

IV.C.1.b.  select compute
IV.C.1.c.  select modify genotypes from the menu and type in different genotypes; compute. Try a different

race if you like.
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With this tool you can examine step-by-step the effect on the calculation of examples involving possible mutation and/or
null alleles.
IV.C.1.d.  Switching between language is: Paternity/Maternity makes a difference when the analysis

involves possible mutation.
IV.C.1.e.  The locus: menu choice lets you select and enter data for an arbitrary locus, including one for which the

case has no actual data.

IV.D.  Case option: Omit names in kinship cases

IV.E.  Kinship analysis detail: calculate one locus, showing parsing
This option from the Immigration/Kinship menu allows you to select any locus.

IV.E.1.  Operation
The screen displays detailed information about the
kinship calculation for that locus, including 
IV.E.1.a.  Parsing
The “parsing” (blue on white background) shows the
child-mother-father trios that the program perceives the
scenario to mean, for each of the hypotheses. This is
debugging/training information.
IV.E.1.b.  Alleles and frequencies
IV.E.1.c.  Genotypes
The actual genotypes are shown, but you may enter different ones if you wish. Hit Esc to proceed to the computation.
IV.E.2.  Uses
The primary intended use for this tool is to let the computer make various trial calculations to help you make a mutation
analysis. When there is an inconsistency somewhere in a presumptive family, sometimes it is possible to reason that the
likelihood in view of the inconsistency can be written as an expression involving one or more likelihoods of related
problems in which one or another allele is changed (mutated).

IV.F.  Kinship – pairwise relationship charts
Two of the menu options under immigration/kinship display a quick calculation of pair-wise comparisons between all
the personae in the case. 
Experimental feature/Caveat! – the LR's calculated are intended to include Y-haplotype matching odds. However,
as of Version 28.35 the Y-haplotype calculation is incorrect when the Y-haplotypes match partially but not exactly. The
id (identity) and pi (parentage) calculations are about right, but the remaining pairwise kinship LR's are too generous.
IV.F.1.  Test all relations

The triangular relationship “distance” matrix
shows pairwise relationship indices (LR)
between each role in the case. Six
relationships are computed: 

id=identity/identical twin
pi=paternity index (duo)
si=sibling index
cuz=cousin index
hsb=half sib/avuncular/grandparent

index (they're all the same)
dcz=double cousin index.



DNA@VIEW March 10, 2007 11:12am 7

However, the chart will show at most the largest one of the last four. Also, in no case will any LR<1/100 be shown.
Therefore any blank cells in the upper triangle, or role letters omitted entirely, mean that all LR<1/100.

IV.F.2.  Kinship – Show pairwise relations

This option is similar to Estimate likely relations, but it lists every LR (that is $1/100) for every role pair and for every
one of the six relationships. The listing is presented as a menu-chart with special key-strokes available to rearrange the
chart. Hit one of the lower-case letters abcdef to sort according to the values in one of the columns id, pi, etc. Hit the
same key again to sort in the opposite order. Sort according to the largest LR in the row with +. Put the red bar on a line
(e.g. by single-left-click) and then del to remove a row. Example: a sorts the combinations A,A  B,B  ... to the
top (since they have the large ID=matching odds figures); down-arrow to move to the first of them; del del del ... to
remove them from the chart.

IV.G.  Kinship Simulation
IV.G.1.  Simulation does [not] complete partial profiles

When running a simulation for a case for which some DNA profiles already exist, there are two kinds of additional data
that one might consider obtaining and therefore want to simulate:
1. Additional people
2. Additional loci.
In either case, there may some loci for some of the previously typed people for which types were not obtained. This
option allows you to specify whether the program should assume that you will re-assay and obtain genotypes to fill out
those profiles, or not.

IV.H.  Import/Export
To import DNA profiles into DNA@VIEW, the data file be tab-delimited Ascii – see manual.
Import DNA profile data with one of two Import/Export options depending on the format of the file.

IV.H.1.  Genotyper import

The input is one row per sample, such as can be produced by the ABI Genotyper® “Allele Table” macro. See the
DNA@VIEW manual for details & procedure.
IV.H.2.  Genemapper import

By this DNA@VIEW means an ABI format that is tall and narrow. It may be an option from the Genotyper for output
as well. See the DNA@VIEW manual, §X.C.6, for an example.
added feature: The import wizard allows a fair amount of flexibility for the input file:
IV.H.2.a.  Column headings

Depending on how it is configured, GeneMapper®
can produce some variation of the output columns.
DNA@VIEW guesses how the GeneMapper columns
correspond to information that DNA@VIEW is
interested in. To guarantee complete flexibility, a
column interpretation screen allows the user to over-
ride any incorrect guesses.
The critical (recognized and imported columns) are
IV.H.2.a.i.)  Sample Info – means the column

containing DNA@VIEW sample names in any of the various allowed formats (DNA@VIEW manual, §X.C.4).
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(If there is a column names "Sample Info" or only one column named "Sample" anything, DNA@VIEW guesses
that it is the Sample Info column. Otherwise, DNA@VIEW requires the user to choose.)

IV.H.2.a.ii.)  Marker – the column with locus names. The word “Category” is recognized as an alternative.
IV.H.2.a.iii.)  Allele – a column or columns with the allele sizes. The word “Peak” is permitted as an alternative

to “Allele” for the heading of the columns containing the locus names. “Allele 1", “Allele 2" etc are ok. If you
were wondering, no, it is not ok to call some of the Allele and
some Peak!

IV.H.2.a.iv.)  Height – optional column or columns with peak heights.
If present, they must be equinumerous with Allele columns.

Esc if all column interpretations are ok; select any row to change the
interpretation for that row.

 


